
Cricket Statistics for Windows    -    Help Contents

Thank you for trying Cricket Statistics for Windows - I hope you find it useful.

You may evaluate the program free of charge for a period of 30 
days but then you must register if you intend to continue using it.

Cricket Statistics for Windows allows you to produce detailed statistics for your club, 
school or league with the minimum of effort.    Facilities are also provided to allow you to 
automate many of the tasks associated with the day to day running of a cricket club.

To choose a help topic, press <Tab> to select the underlined topic you want to view, and 
then press <Enter>.    With the mouse, point to the underlined topic you want to view, and 
then click the left mouse button.    You can scroll down the display to see more topics.

For more information on using Help, press <F1>.

To return to this topic, click the Index button (Windows 3.0) or Contents button (Windows 
3.1 or later).
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How to use Cricket Statistics for Windows

Cricket Statistics for Windows has been designed to be easy to use, the following topics
give a brief overview of the main aspects of its operation:

Getting Started
Configuring Cricket Statistics for Windows
Entering Data
Producing Statistics
Administration Utilities



Commands

The following commands are accessed from the menu at the top of the Cricket Statistics 
for Windows screen:

File Menu
Edit Menu
Statistics Menu
Admin Menu
Options Menu
Help Menu
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Support

Registered users will be entitled to unlimited free support and will also be able to obtain 
any future upgrades for a minimal fee (to cover the cost of the disk and post and packing).

If you encounter a problem, please write to me at the following address: 

Grahame Giddings
76, Springwell Road,
Heston,
Middx    TW5 9EJ
England

Or contact me via email at:

ggiddings@cix.compulink.co.uk

Please include details of the problem and the events leading up to 
it together with your name, address, phone number and, if you 
have one, your email address.



Removing Cricket Statistics For Windows

If you decide to remove Cricket Statistics for Windows from your hard disk, you should 
perform the following steps:

1. In the Windows Program Manager, select the Cricket Statistics for Windows group by 
clicking it once, select the Delete option from the File menu and then click the 'Yes' 
button on the resulting dialogue.

2. Using the Windows File Manager, locate the sub-directory in which any existing DLL and 
VBX files were backed up during installation (default    cricket\backup).    You should then 
compare these files with the versions installed by the Cricket Statistics program (these 
will normally be located in the windows\system directory) and, if there are any 
differences, I suggest you copy the backed-up files to a safe place (e.g. to a floppy disk).

3. Using the Windows File Manager, delete the directory tree containing Cricket Statistics 
for Windows    -    select the top-level directory (default    \cricket), select the Delete 
option from the File menu and click the 'Yes' button on all the resulting dialogues.

4. Still using the Windows File Manager, locate the cri-stat.ini configuration file (normally 
located in the windows directory) and delete it.

5. If you saved the backed-up DLL and VBX files in step (2) above, you should check that 
your system is operating correctly before finally deleting them.



Getting Started

You can start Cricket Statistics for Windows from the Windows Program Manager simply
by double clicking on its icon.    This will start the program and you can then load a 
database using the Open command in the File Menu.

If required, you can set up the Windows Program Manager to load a particular database 
when you start Cricket Statistics for Windows.

You can also set up the Windows File Manager to start Cricket Statistics for Windows 
and load a selected database by double clicking on a database file.

Cricket Statistics for Windows is supplied with a sample database for the Ottershaw 
Cricket Club 1991 season for you to experiment with (it's just coincidence that this was one
of the author's best seasons !!!).    The database is called occ1991 and is stored in the 
sample sub-directory.

Before going any further, you should check that Cricket Statistics for Windows is 
correctly configured for your system.



Automatic Database Loading

You can configure the Windows Program Manager to automatically load a particular 
database when you start Cricket Statistics for Windows.

In the Windows Program Manager:

1. Select the Cricket Statistics for Windows icon by clicking on it once

2. Select Properties from the File Menu

3. Add the path of the required database to the end of the Command Line 
entry.    For example:

c:\cricket\cricket.exe c:\cricket\sample\occ1991

4. Click the OK button

You will now find that when you double click the Cricket Statistics for Windows icon, the
program will start and automatically load the occ1991 database.



Loading a Selected Database

You can configure the Windows File Manager to automatically start Cricket Statistics for 
Windows with a particular database already loaded when you double click on one of the 
files in that database.

In the Windows File Manager:

1. Select one of the Cricket Statistics for Windows database files by clicking 
on it once (I suggest you select one of the files with the .av extension)

2. Select Associate from the File Menu

3. Enter the path of the Cricket Statistics for Windows program in the 
Associate With field.    For example:

c:\cricket\cricket.exe

4. Click the OK button

You will now find that when you double click on any file with the .av extension, Cricket 
Statistics for Windows will automatically start with the selected database already 
loaded.



Database Files

The Cricket Statistics for Windows database files have the following extensions:

.av . plr . dat . fix    .mch



Configuring Cricket Statistics for Windows

Cricket Statistics for Windows can be configured to suite your computer system and the
way you want to work.

Most options can be selected 'on the fly' however, it is necessary to set up certain 
parameters before you start:

Auto Save
Sound
Tool Tips
User Preferences
Printer Fonts
Label Format
Dialler Setup



Entering Data

Data for Cricket Statistics for Windows is held in a number of databases, each of which 
contains all the information for a club for a single season.    This information is divided into 
the following categories:

Database Information
Players
Matches



Producing Statistics

Cricket Statistics for Windows can process data from one or more clubs over one or 
more seasons and produce a range of pre-defined reports, for up to 10000 players, which 
may be previewed on the screen, exported to another application (via the Windows 
Clipbaoard) or output directly to your printer:

Overall Summary
Match Review
Record Partnerships
Batting Averages
Bowling Averages
Fielding Summary
Wicket Keeping Summary
Fantasy Cricket
Captains' Summary
Duck Cup
Personal Review



Administration Utilities

Cricket Statistics for Windows provides a number of utilities to help with the day-to-day
running of your club:

Player Database
Phone Book
Print Availabilities
Print Rota



How to Register

You may evaluate Cricket Statistics for Windows free of charge for 
a period of 30 days but then you must register if you intend to 
continue using it.

The unregistered version of Cricket Statistics for Windows only supports a single database but it only 
costs £20.00 to register and this will enable you to work with multiple databases and will stop the 
annoying registration reminder dialogue being displayed.    I will be donating half of this 
registration fee to the colts section of my club (Ottershaw Cricket Club) to help cover their 
ever increasing costs and so, hopefully, ensure that the game I love continues on into the 
next century.

Registered users will be entitled to unlimited free support and will also be able to obtain 
any future upgrades for a minimal fee (to cover the cost of the disk and post and packing).

To register, please complete the order form and mail it, together with your cheque/postal 
order for £20.00, to the following address:

Grahame Giddings
76, Springwell Road,
Heston,
Middx    TW5 9EJ
England

In return, you will be sent a registration pack containing your unique registration number 
and, if you are currently running an earlier version of the program, the latest version of 
Cricket Statistics for Windows on the disk format of your choice.

When you receive your registration pack, you should install the latest version of the 
program (if necessary) and then enter your registration details.



Limitations of the Unregistered Version

The unregistered version of    Cricket Statistics for Windows is limited to a single 
database.

The registered version supports multiple databases and does not display the annoying 
registration reminder dialogue.

If you want to evaluate the program using data for your own club, you will first need to 
delete the sample database, which consists of the following files, from the sample sub-
directory:

occ1991.av
occ1991.plr
occ1991.dat
occ1991.fix
occ1991.mch



File Menu

The File Menu contains the following commands:

New
Open
Save
Save As
Print Setup
Exit



New    (File Menu)

The New command allows you to create a new database.    You will be asked to specify the 
club name, year and season for the new database, you will be given the option of copying 
the players' names and details from another (existing) database and, finally, you will be 
given the option of saving the new database.

Club Name
Year
Season Options
OK Button
Cancel Button



Club Name

The Club Name can be 1 - 30 characters long and will be capitalised.



Valid Characters

The following characters can appear in the Club Name:

a - z    A - Z    0 - 9    &    ,    .    -    /    '    <space>

Note: You cannot enter two consecutive spaces.



Capitalised Text

If any of the following characters appear in the Club Name, the next character will 
automatically be converted to upper-case:

&    ,    .    -    /    <space>

Also, if either of the following appear at the beginning of a word, the next character will 
automatically be converted to upper-case:

'
Mc



Year

The Year can be in the range 1600 - 9999 (if the Jan - Dec season option is selected) or 
1600 - 9998 (if the Jul - Jun season option is selected).



Season Options

The season can run from Jan - Dec or Jul - Jun.



Jan - Dec Season

Select Jan - Dec if the season runs from 1st January - 31st December the same year.



Jul - Jun Season

Select Jul - Jun if the season runs from 1st July - 30th June the following year.    For 
example, if the year is 1992, the season runs from 1st July 1992 - 30th June 1993.

Note: If the Year has been set to 9999, the Jul - Jun option will be 'greyed-out'.



OK button

Click the OK button to create a new database with the specified club name, year and 
season.    You will then be given the option of copying the players' names and details from 
another (existing) database into the new database and, finally, you will be given the option 
of saving the new database.



Cancel Button

Click the Cancel button to continue without creating a new database.



Open    (File Menu)

The Open command allows you to open an existing database to, for example, add/edit 
players or matches, use the phone book, print a rota etc.

Drive List
Directory List
Database List
File Name
OK Button
Cancel Button



Drive List

Select the drive, where the database you want to open resides, from the Drive List.



Directory List

Select the directory, where the database you want to open resides, from the Directory 
List.



Database List

Select the database you want to open from the Database List.



File Name

The File Name is the name of the database (the relevant file extensions will be added 
automatically for each individual file in the database) you want to open and can be 4 - 8 
characters long.

You can enter a file name directly into this field or the name will be filled in automatically, 
together with the Club Name and Year, when you select a database from the Database List.



Valid Characters

The following characters can appear in the File Name:

a - z    A - Z    0 - 9



OK Button

Click the OK button to open the selected database.



Cancel Button

Click the Cancel button to continue without opening a database.



Save    (File Menu)

The Save command saves the currently loaded database.



Save As    (File Menu)

The Save As command allows you to save the currently loaded database under a different 
name, in a different directory or on a different drive.

Drive List
Directory List
Database List
File Name
OK Button
Cancel Button



Drive List

Select the drive, where you want to save the currently loaded database, from the Drive 
List.



Directory List

Select the directory, where you want to save the currently loaded database, from the 
Directory List.



Database List

If you want to save the currently loaded database under an existing name, select the 
required database from the Database List.



File Name

The File Name is the name of the database (the relevant extensions will be added 
automatically for each individual file in the database) you want to save and can be 4 - 8 
characters long.

Note: The last four characters of the file name must be the same as the year 
defined for the database.

You can enter a database name directly into this field or the name will be filled in 
automatically, together with the Club Name and Year, when you select a database from the 
Database List.



Valid Characters

The following characters can appear in the File Name:

a - z    A - Z    0 - 9



OK Button

Click the OK button to save the currently loaded database.



Cancel Button

Click the Cancel button to continue without saving the currently loaded database.



Print Setup    (File Menu)

The Print Setup command allows you to select the Windows Default Printer and to 
control the settings for that printer.

Note: If you are using Windows Version 3.0, you may find that certain fields in the 
printer setup dialogues are 'greyed out'.    If this is the case, and you wish to alter 
these fields, you can do so using the Printers option in the Windows Control Panel.



Exit    (File Menu)

The Exit command ends the current Cricket Statistics for Windows session.

If there is a database loaded and this database has not been saved since it was last 
changed, you will be given the option of saving it before exiting.



Copy Players' Details

When you are creating a new database, you can save yourself a great deal of time and 
effort by copying the players' names and details from another (existing) database into the 
new database:

Drive List
Directory List
Database List
File Name
OK Button
Cancel Button



Drive List

Select the drive, where the database you want to copy the players' details from resides, 
from the Drive List.



Directory List

Select the directory, where the database you want to copy the players' details from resides,
from the Directory List.



Database List

Select the database, which you want to copy the players' details from, from the Database 
List.



File Name

The File Name defines the name of the database (the relevant extensions will be added 
automatically for each individual file in the database) you want to copy the players' details 
from and can be 4 - 8 characters long.

You can enter a database name directly into this field or the name will be filled in 
automatically, together with the Club Name and Year, when you select a database from the 
Database List.



Valid Characters

The following characters can appear in the File Name:

a - z    A - Z    0 - 9



OK Button

Click the OK button to copy the players' details from the selected database into the new 
database.



Cancel Button

Click the Cancel button to continue without copying any players' details into the new 
database.



Edit Menu

The Edit Menu contains the following commands:

Club/Year
Players
Matches



Club/Year    (Edit Menu)

The Club/Year command allows you to edit the club name, year and season of the 
currently loaded database.

Club Name
Year
Season Options
OK Button
Cancel Button



Club Name

The Club Name can be 1 - 30 characters long and will be capitalised.



Valid Characters

The following characters can appear in the Club Name:

a - z    A - Z    0 - 9    &    ,    .    -    /    '    <space>

Note: You cannot enter two consecutive spaces.



Capitalised Text

If any of the following characters appear in the Club Name, the next character will 
automatically be converted to upper-case:

&    ,    .    -    /    <space>

Also, if either of the following appear at the beginning of a word, the next character will 
automatically be converted to upper-case:

'
Mc



Year

The Year can be in the range 1600 - 9999 (if the Jan - Dec season option is selected) or 
1600 - 9998 (if the Jul - Jun season option is selected).



Season Options

The season can run from Jan - Dec or Jul - Jun.



Jan - Dec Season

Select Jan - Dec if the season runs from 1st January - 31st December the same year.



Jul - Jun Season

Select Jul - Jun if the season runs from 1st July - 30th June the following year.    For 
example, if the year is 1992, the season runs from 1st July 1992 - 30th June 1993.

Note: If the Year has been set to 9998, the Jul - Jun option will be 'greyed-out'.



OK button

Click the OK button to accept the changes to the club name, year and season.    If any of 
these parameters have changed, you will be given the option of saving the database under 
a new name.



Cancel Button

Click the Cancel button to retain the original club name, year and season.



Players    (Edit Menu)

The Players command allows you to add new players, view or edit existing players and 
print a list of players' names:

Player List
Add Button
Edit Button
Print Button
Cancel Button



Player List

The Player List contains the names of all the (max 200) players in the currently loaded 
database sorted in alphabtical order.    If you want to view or edit a player's name or details,
select the player from the list and click the Edit button or double-click on the required 
player.



Add Button

Click the Add button to add a new player.

Note: If there are already 200 players in the currently loaded database, the Add 
button will be 'greyed-out'.



Edit Button

Click the Edit button to view or edit the selected player.



Print Button

Click the Print button to print a list of all the players' names.



Cancel Button

Click the Cancel button to finish adding, viewing or editing the players' names and details.



Player Details

The Player Details window allows you to add, view or edit a player's name, address, 
phone numbers and membership details:

Initials
Surname
Address
Home Phone
Work Phone
Mobile Phone
Membership
Sub Paid
OK Button
Cancel Button



Initials

The player's Initials can be 1 or 2 characters long and will automatically be converted to 
upper-case.



Valid Characters

The following characters can appear in a player's Initials:

a - z    A - Z



Surname

The player's Surname can be 1 - 12 characters long and will be capitalised.



Valid Characters

The following characters can appear in a player's Surname:

a - z    A - Z    -    '



Capitalised Text

If    the following character appears in a player's Surname, the next character will 
automatically be converted to upper-case:

-    

Also, if either of the following appear at the beginning of the surname, the next character 
will automatically be converted to upper-case:

'
Mc



Address

The player's Address can contain up to 3 lines, each of which can be up to 25 characters 
long.    The first 2 lines of the address will be capitalised and the third line will automatically
be converted to all upper-case.



Valid Characters

The following characters can appear in a player's Address:

a - z    A - Z    0 - 9    ,    .    -    /    '    <space>

Note: You cannot enter two consecutive spaces.



Capitalised Text

If any of the following characters appear in the first two lines of the player's Address, the 
next character will automatically be converted to upper case:

&    ,    .    -    /    <space>

Also, if either of the following appear at the beginning of a word, the next character will 
automatically be converted to upper-case:

'
Mc



Home Phone

The player's Home Phone number can be up to 20 characters long.



Valid Characters

The following characters can appear in a player's Home Phone number:

0 - 9    -    <space>

Note: You cannot enter two consecutive spaces.



Work Phone

The player's Work Phone number can be up to 20 characters long.

Note: The Work Phone number can include an extension number, prefixed by an 'x' 
or 'X', but this extension will not be included in the number dialled by the Phone Book
auto-dialler.



Valid Characters

The following characters can appear in a player's Work Phone number:

0 - 9    -    x    X    <space>

Note: You cannot enter two consecutive spaces.



Mobile Phone

The player's Mobile Phone number can be up to 20 characters long.

Note: The Mobile Phone number can alternatively be used to hold a pager number.    
In this case the number may include a pager code, prefixed by an alpha character, 
but this code will not be included in the number dialled by the Phone Book auto-
dialler.



Valid Characters

The following characters can appear in a player's Mobile Phone number:

a - z    A - Z    0 - 9    -    <space>

Note: You cannot enter two consecutive spaces.



Membership

Select the player's Membership type from the list of possible membership types.

The membership types available may be changed using the User Preferences command.



Sub Paid

Check the Sub Paid box if the player has paid his subscription.



OK Button

Click the OK button to accept the changes to the player's name and details.

Note: If you have changed the player's name, every occurrence of that player's 
name in matches in the currently loaded database will be changed automatically.



Cancel Button

Click the Cancel button to continue without adding or editing the player's details.



Matches    (Edit Menu)

The Matches command allows you to add new matches, view or edit existing matches and 
print a list of matches:

Match List
Add Button
Edit Button
Print Button
Cancel Button



Match List

The Match List contains all the (max 160) matches in the currently loaded database 
sorted in chronological order.    If you want to view or edit a match, select the match from 
the list and click the Edit button or double-click on the required match.



Add Button

Click the Add button to add a new match.

Note: If there are already 160 matches in the currently loaded database, the Add 
button will be 'greyed-out'.



Edit Button

Click the Edit button to view or edit the selected match.



Print Button

Click the Print button to print a list of all the matches.



Cancel Button

Click the Cancel button to finish adding, viewing or editing matches.



Match Details

The Match Details window allows you to add, view or edit the date, team, opposition, 
venue, type of match, home score, home wickets, opposition score, opposition wickets, 
number of overs in each innings, result, winning/losing margin, fall of wickets and outgoing 
batsmen or print a score card for the match:

Date
Team
Opposition
Venue
Type of Match
Home Score
Home Wickets
Home Overs
Opposition Score
Opposition Wickets
Opposition Overs
Result
Winning/Losing Margin
Fall of Wickets
Outgoing Batsmen
OK Button
Batting Button
Bowling Button
Print Button
Cancel Button

Further windows can be opened to allow you to add, view or edit the batting details and 
bowling details.



Date

The Date may be entered in a number of ways depending upon the date format defined in 
the International section of the Windows Control Panel.    For the U.K., the following formats 
are accepted:

27Jun
27jun
27-Jun
27-jun
27/6
27/06



Team

The Team can be in the range 1 - 9.



Opposition

The Opposition can be 1 - 20 characters long and will be capitalised.



Valid Characters

The following characters can appear in the Opposition name:

a - z    A - Z    0 - 9    &    ,    .    -    /    '    <space>

Note: You cannot enter two consecutive spaces.



Capitalised Text

If any of the following characters appear in the Opposition name, the next character will 
automatically be converted to upper case:

&    ,    .    -    /    <space>

Also, if either of the following appear at the beginning of a word, the next character will 
automatically be converted to upper-case:

'
Mc



Venue

Select the Venue from the following list:

Home
Away



Type of Match

Select the Type of Match from the list of possible match types.

The match types available may be changed using the User Preferences command.



Home Score

The Home Score indicates your club's score and can be in the range 0 - 999.

Extensive error checking is performed to ensure that the scores, result and margin you 
enter are consistent.



Home Wickets

The Home Wickets indicates the number of wickets your club lost and can be in the range
0 - 10.

Extensive error checking is performed to ensure that the scores, result and margin you 
enter are consistent.



Home Overs

The Home Overs indicates the number of overs bowled in your club's innings and can be 
in the range 0 - 99.5.



Opposition Score

The Opposition Score can be in the range 0 - 999.

Extensive error checking is performed to ensure that the scores, result and margin you 
enter are consistent.



Opposition Wickets

The Opposition Wickets can be in the range 0 - 10.

Extensive error checking is performed to ensure that the scores, result and margin you 
enter are consistent.



Opposition Overs

The Opposition Overs indicates the number of overs bowled in the opposition's innings 
and can be in the range 0 - 99.5.



Result

Select the Result from the following list:

Won
Lost
Drawn
Tied
Abandoned
Cancelled

Extensive error checking is performed to ensure that the scores, result and margin you 
enter are consistent.



Winning/Losing Margin

If the match was Won or Lost, you can specify the way in which the match was decided:

Runs
Wickets
Run Rate
Wkts Lost
Conceded

If you select Runs or Wickets, the winning/losing margin (i.e. the number of runs or 
wickets by which you won/lost) will be filled in automatically.    Extensive error checking is 
performed to ensure that the scores, result and margin you enter are consistent.

Note: If the result was not Won or Lost, the winning/losing margin fields will be 
'greyed out'.



Fall of Wickets

The Fall of Wickets are the scores at which the wickets fell in your club's innings and can 
be in the range 0 - your club's total score.



Outgoing Batsmen

The Outgoing Batsmen are the batsmen who were out at the fall of each wicket in your 
club's innings and can be in the range 1 - 11.



OK Button

Click the OK button to accept the changes to the match.



Batting Button

Click the Batting button to switch to the batting details window.



Bowling Button

Click the Bowling button to switch to the bowling details window.



Print Button

Click the Print button to print a score card for the match.



Cancel Button

If you are adding a new match, click the Cancel button to continue without saving the new 
match.

If you are editing an existing match, click the Cancel button to continue without saving the
changes.



Batting Details

The Batting Details window allows you to add, view or edit the player's names, their 
scores, number of sixes, catches and stumpings and to indicate who was the captain and 
wicket keeper:

Initials
Surname
Spin Buttons
Captain
Wicket Keeper
Score
Sixes
Catches
Stumpings
Match Button
Bowling Button

Further windows can be opened to allow you to add, view or edit the match details and 
bowling details.



Initials

The player's Initials can be 1 or 2 characters long and will automatically be converted to 
upper-case.    Instead of typing the player's name, you can scroll up and down through the 
players in the currently loaded database using the cursor up and down keys or the Spin 
buttons.

Note: The name you enter will be validated against the players in the currently 
loaded database and, if no match is found, you will be given the option of adding the 
new player to the database.



Valid Characters

The following characters can appear in a player's Initials:

a - z    A - Z



Surname

The player's Surname can be 1 - 12 characters long and will be capitalised.    Instead of 
typing the player's name, you can scroll up and down through the players in the currently 
loaded database using cursor up and down keys or the Spin buttons.

Note: The name you enter will be validated against the players in the currently 
loaded database and, if no match is found, you will be given the option of adding the 
new player to the database.



Valid Characters

The following characters can appear in a player's Surname:

a - z    A - Z    -    '



Capitalised Text

If the following character appears in a player's Surname, the next character will 
automatically be converted to upper case:

- 

Also, if either of the following appear at the beginning of the surname, the next character 
will automatically be converted to upper-case:

'
Mc



Spin Buttons

Use the Spin buttons to select a player by scrolling up and down through the players in the
currently loaded database.



Captain

Check the Captain box to indicate that the player captained the match.



Wicket Keeper

Check the Wicket Keeper box to indicate that the player kept wicket.



Score

The player's Score can be in the range 0 - 999, the * character is used to indicate 'not out'.



Sixes

The number of Sixes hit can be in the range 0 - 99.



Catches

The number of Catches taken can be in the range 0 - 10.



Stumpings

The number of Stumpings made can be in the range 0 - 10.



Match Button

Click the Match button to switch to the match details window.



Bowling Button

Click the Bowling button to switch to the bowling details window.



Bowling Details

The Bowling Details window allows you to add, view or edit the overs, maidens, wickets 
and runs conceded for each of the players who bowled:

Overs
Maidens
Wickets
Runs
Match Button
Batting Button

Further windows can be opened to allow you to add, view or edit the match details and 
batting details.



Overs

The number of Overs bowled can be in the range 0 - 99.5.    Incomplete overs are 
expressed as overs.balls, for example, 13 overs and 4 balls should be entered as 13.4.



Maidens

The number of Maidens bowled can be in the range 0 - number of complete overs bowled 
by that player.



Wickets

The number of wickets taken can be in the range 0 - 10.



Runs

The number of Runs conceded can be in the range 0 - 999.



Match Button

Click the Match button to switch to the match details window.



Batting Button

Click the Batting button to switch to the batting details window.



Statistics Menu

The Statistics Menu contains the following commands:

Overall Summary
Match Review
Record Partnerships
Batting Averages
Bowling Averages
Fielding Summary
Wicket Keeping Summary
Fantasy Cricket
Captains' Summary
Duck Cup
Personal Review



Drive List

Select the drive, where the database(s) you want to process reside, from the Drive List.



Directory List

Select the directory, where the database(s) you want to process reside, from the Directory
List.



Database List

Select the database(s) you want to process from the Database List.

Note: You can select multiple databases by selecting the first database and then 
holding down the <CTRL> key as you select the subsequent databases or you can 
select a range of databases by selecting the first database and then holding down the
<SHIFT> key as you select the last database.



Statistics Heading

The Statistics Heading is the text which will be displayed/printed at the top of your 
statistics reports.    It consists of two components:

Club Name The Club Name can be 1 - 30 characters long and will be capitalised.    If all the
databases you select from the Database List have the same Club Name, this 
portion of the Statistics Heading will be filled in automatically and can then be 
edited if required.

Year The Year will be filled in automatically with the range of databases you have 
selected from the Database List and can not be changed.



Valid Characters

The following characters can appear in the Statistics Heading:

a - z    A - Z    0 - 9    &    ,    .    -    /    '    <space>

Note: You cannot enter two consecutive spaces.



Capitalised Text

If any of the following characters appear in the Statistics Heading, the next character will
automatically be converted to upper-case:

&    ,    .    -    /    <space>

Also, if either of the following appear at the beginning of a word, the next character will 
automatically be converted to upper-case:

'
Mc



Database Sort Mode

You can select whether the Database List is sorted by Club or Year.



Club

Select the Club Database Sort Mode if you want the Database List sorted by club name.



Year

Select the Year Database Sort Mode if you want the Database List sorted chronologically.



Day

Select the Day you want to process from the following list:

All
Saturday
Sunday
Monday
Tuesday
Wednesday
Thursday
Friday

Note: You can select multiple days (eg. Saturday, Monday and Wednesday) by 
selecting the first day and then holding down the <CTRL> key as you select the 
subsequent days or you can select a range of days (eg. Saturday - Wednesday) by 
selecting the first day and then holding down the <SHIFT> key as you select the last
day.



Team

Select the Team you want to process from the following list:

All
1
2
3
4
5
6
7
8
9

Note: You can select multiple teams (eg. 1, 3 and 5) by selecting the first team and 
then holding down the <CTRL> key as you select the subsequent teams or you can 
select a range of teams (eg. 1 - 5) by selecting the first team and then holding down 
the <SHIFT> key as you select the last team.



Type of Match

Select the Type of Match you want to process from the list of possible membership types.

The match types available may be changed using the User Preferences command.

Note: You can select multiple match types (eg. Friendly, League and Tour) by 
selecting the first type and then holding down the <CTRL> key as you select the 
subsequent types or you can select a range of match types (eg. Friendly, League, 
Cup, Tour) by selecting the first type and then holding down the <SHIFT> key as you
select the last type.



Overall Summary    (Statistics Menu)

The Overall Summary command allows you to produce a report, for one or more clubs 
over one or more seasons, showing the total number of matches played, won, lost, drawn 
etc., the total number of players, the number of players who bowled, the total runs and 
wickets for/against, the average number of runs per wicket for/against and, if you have 
entered the number of overs for all the selected matches, the total overs for/against and 
the corresponding run rates:

Drive List
Directory List
Database List
Statistics Heading
Database Sort Mode
Day
Team
Type of Match
Print Button
Preview Button
Cancel Button



Print Button

Click the Print button to print the Overall Summary report.



Preview Button

Click the Preview button to preview the Overall Summary report.



Cancel Button

Click the Cancel button to continue without producing an Overall Summary report.



Overall Summary Preview

The Overall Summary Preview allows you to view the selected Overall Summary before 
printing:

Print Button
Cancel Button

You can copy the Overall Summary to the Windows Clipboard, from where it may be pasted 
into other applications, by pressing the <CTRL> and <INSERT> or <CTRL> and <C> 
keys together.



Print Button

Click the Print button to print the Overall Summary.



Cancel Button

Click the Cancel button to exit from the Overall Summary preview.



Match Review    (Statistics Menu)

The Match Review command allows you to produce a review, for one or more clubs over 
one or more seasons, of the results, home and oppostion scores, home and opposition 
overs, partnerships and best batting and bowling performances for each match:

Drive List
Directory List
Database List
Statistics Heading
Database Sort Mode
Day
Team
Type of Match
Print Button
Preview Button
Cancel Button



Print Button

Click the Print button to print the Match Review report.



Preview Button

Click the Preview button to preview the Match Review report.



Cancel Button

Click the Cancel button to continue without producing a Match Review report.



Match Review Preview

The Match Review Preview allows you to view the selected Match Review before printing:

Previous Year Button
Print Button
Preview Mode Button
Cancel Button
Next Year Button

You can copy the Match Review to the Windows Clipboard, from where it may be pasted 
into other applications, by pressing the <CTRL> and <INSERT> or <CTRL> and <C> 
keys together.



Previous Year Button

Click the Previous Year button to preview the Match Review for the previous year.

Note: If the Match Review was only requested for a single year, the Previous Year 
button will not be shown.    Alternatively, if multiple years were requested and the 
Match Review currently displayed is for the first of these, the Previous Year button will
be 'greyed-out'.



Print Button

Click the Print button to print the Match Review.



Preview Mode Button

Click the Preview Mode button to switch between the following modes:

Results & Scores
Partnerships
Batting/Bowling



Cancel Button

Click the Cancel button to exit from the Match Review preview.



Next Year Button

Click the Next Year button to preview the Match Review for the next year.

Note: If the Match Review was only requested for a single year, the Next Year button
will not be shown.    Alternatively, if multiple years were requested and the Match 
Review currently displayed is for the last of these, the Next Year button will be 
'greyed-out'.



Record Partnerships    (Statistics Menu)

The Record Partnerships command allows you to produce a report, for one or more clubs
over one or more seasons, showing the record batting partnerships:

Drive List
Directory List
Database List
Statistics Heading
Database Sort Mode
Day
Team
Type of Match
Number of Partnerships
Minimum Score
Print Button
Preview Button
Cancel Button



Number of Partnerships

The Number of Partnerships for each wicket to be included in the Record Partnerships 
report can be in the range 1 - 99.

Note: If this field is left blank, only the highest partnership (if it is equal to or greater
than the Minimum Score) for each wicket will be included in the report.



Minimum Score

The Minimum Score for a partnership to be included in the Record Partnerships report can
be in the range 0 - 999.

Note: If this field is left blank, all partnerships (up to the Number of Partnerships) for
each wicket will be included in the report.



Print Button

Click the Print button to print the Record Partnerships report.



Preview Button

Click the Preview button to preview the Record Partnerships report.



Cancel Button

Click the Cancel button to continue without producing a Record Partnerships report.



Record Partnerships Preview

The Record Partnerships Preview allows you to view the selected Record Partnerships report
before printing:

Print Button
Cancel Button

You can copy the Record Partnerships to the Windows Clipboard, from where they may be 
pasted into other applications, by pressing the <CTRL> and <INSERT> or <CTRL> and 
<C> keys together.



Print Button

Click the Print button to print the Record Partnerships.



Cancel Button

Click the Cancel button to exit from the Record Partnerships preview.



Batting Averages    (Statistics Menu)

The Batting Averages command allows you to produce the batting averages for one or 
more clubs over one or more seasons:

Drive List
Directory List
Database List
Statistics Heading
Database Sort Mode
Day
Team
Type of Match
Sort Mode
Qualification
Print Button
Preview Button
Cancel Button



Sort Mode

The Batting Averages can be sorted on:

Average Runs per (completed) innings
Runs Total number of runs scored
Innings Total number of innings
Highest Score Highest score
Major Highlight Number of times the major highlight (default 100 runs) was achieved
Minor Highlight Number of times the major highlight (default 50 runs) was achieved
6's Total number of sixes
Matches Total number of matches played
Name Players' names

Note: If either the Major Highlight or Minor Highlight option is selected, only players 
who achieved that highlight at least once will be included in resulting report.



Qualification

You can choose to split the Batting Averages into two lists based on:

Runs Total number of runs scored
Innings Total number of innings
Matches Total number of matches played

The number of Runs/Innings/Matches necessary to qualify for the main Batting Averages 
can be in the range 0 - 9999,    players failing to satisfy the qualification will be included in 
an 'Also Batted' list.

Note: If this field is left blank, all players will be included in a single list.



Print Button

Click the Print button to print the Batting Averages report.



Preview Button

Click the Preview button to preview the Batting Averages report.



Cancel Button

Click the Cancel button to continue without producing a Batting Averages report.



Batting Averages Preview

The Batting Averages Preview allows you to view the selected Batting Averages before 
printing:

Print Button
Cancel Button

You can copy the Batting Averages to the Windows Clipboard, from where they may be 
pasted into other applications, by pressing the <CTRL> and <INSERT> or <CTRL> and 
<C> keys together.



Print Button

Click the Print button to print the Batting Averages.



Cancel Button

Click the Cancel button to exit from the Batting Averages preview.



Bowling Averages    (Statistics Menu)

The Bowling Averages command allows you to produce the bowling averages for one or 
more clubs over one or more seasons:

Drive List
Directory List
Database List
Statistics Heading
Database Sort Mode
Day
Team
Type of Match
Sort Mode
Qualification
Print Button
Preview Button
Cancel Button



Sort Mode

The Bowling Averages can be sorted on:

Average Runs per wicket
Economy Rate Runs conceded per over
Strike Rate Balls per wicket
Overs Total number of overs
Maidens Total number of maidens
Wickets Total number of wickets
Runs Total number of runs conceded
Best Bowling Best bowling figures
Highlight Number of times the bowling highlight (default 5 wkts) was achieved
Matches Total number of matches played
Name Players' names

Note: If the Highlight option is selected, only players who achieved that highlight at 
least once will be included in resulting report.



Qualification

You can choose to split the Bowling Averages into two lists based on:

Wickets Total number of wickets
Overs Total number of overs
Matches Total number of matches played

The number of Wickets/Overs/Matches necessary to qualify for the main Bowling Averages 
can be in the range 0 - 9999,    players failing to satisfy the qualification will be included in 
an 'Also Bowled' list.

Note: If this field is left blank, all players will be included in a single list.



Print Button

Click the Print button to print the Bowling Averages report.



Preview Button

Click the Preview button to preview the Bowling Averages report.



Cancel Button

Click the Cancel button to continue without producing a Bowling Averages report.



Bowling Averages Preview

The Bowling Averages Preview allows you to view the selected Bowling Averages before 
printing:

Print Button
Cancel Button

You can copy the Bowling Averages to the Windows Clipboard, from where they may be 
pasted into other applications, by pressing the <CTRL> and <INSERT> or <CTRL> and 
<C> keys together.



Print Button

Click the Print button to print the Bowling Averages.



Cancel Button

Click the Cancel button to exit from the Bowling Averages preview.



Fielding Summary    (Statistics Menu)

The Fielding Summary command allows you to produce a report, for one or more clubs 
over one or more seasons, showing the catches taken by each player:

Drive List
Directory List
Database List
Statistics Heading
Database Sort Mode
Day
Team
Type of Match
Sort Mode
Print Button
Preview Button
Cancel Button

Note: The Fielding Summary only includes catches taken by out-fielders, wicket 
keepers' catches are included in the Wicket Keeping Summary.



Sort Mode

The Fielding Summary can be sorted on:

Catches Total number of catches
Name Players' names



Print Button

Click the Print button to print the Fielding Summary report.



Preview Button

Click the Preview button to preview the Fielding Summary report.



Cancel Button

Click the Cancel button to continue without producing a Fielding Summary report.



Fielding Summary Preview

The Fielding Summary Preview allows you to view the selected Fielding Summary before 
printing:

Print Button
Cancel Button

You can copy the Fielding Summary to the Windows Clipboard, from where it may be pasted
into other applications, by pressing the <CTRL> and <INSERT> or <CTRL> and <C> 
keys together.



Print Button

Click the Print button to print the Fielding Summary.



Cancel Button

Click the Cancel button to exit from the Fielding Summary preview.



Wicket Keeping Summary    (Statistics Menu)

The Wicket Keeping Summary command allows you to produce a report, for one or more
clubs over one or more seasons, showing the dismissals achieved by each wicket keeper:

Drive List
Directory List
Database List
Statistics Heading
Database Sort Mode
Day
Team
Type of Match
Sort Mode
Print Button
Preview Button
Cancel Button



Sort Mode

The Wicket Keeping Summary can be sorted on:

Dismissals Total number of dismissals
Catches Total number of catches
Stumpings Total number of stumpings
Matches Total number of matches as wicket keeper 
Name Players' names



Print Button

Click the Print button to print the Wicket Keeping Summary report.



Preview Button

Click the Preview button to preview the Wicket Keeping Summary report.



Cancel Button

Click the Cancel button to continue without producing a Wicket Keeping Summary report.



Wicket Keeping Summary Preview

The Wicket Keeping Summary Preview allows you to view the selected Wicket Keeping 
Summary before printing:

Print Button
Cancel Button

You can copy the Wicket Keeping Summary to the Windows Clipboard, from where it may be
pasted into other applications, by pressing the <CTRL> and <INSERT> or <CTRL> and 
<C> keys together.



Print Button

Click the Print button to print the Wicket Keeping Summary.



Cancel Button

Click the Cancel button to exit from the Wicket Keeping Summary preview.



Fantasy Cricket (Statistics Menu)

You may find it a bit of fun, and a way of raising some money for your club, to run a 
Fantasy Cricket competition similar to those recently launched by a number of national 
newspapers.    The rules and scoring systems of these competitions vary but, in general, the
idea is to select a team of 11 from the 250 or so players in the county championship.    The 
winner is the person whose team accumulates the most points for their battting, bowling 
and fielding performances throughout the season.

The Fantasy Cricket command allows you to produce a report, for one or more clubs over 
one or more seasons, showing each player's Fantasy Cricket Rating based on their batting, 
bowling and fielding performances:

Drive List
Directory List
Database List
Statistics Heading
Database Sort Mode
Day
Team
Type of Match
Sort Mode
Print Button
Preview Button
Cancel Button



Fantasy Cricket Rating
 
A player's Fantasy Cricket Rating is based on:

Total number of runs scored
Number of times the major batting highlight (default 100 runs) was achieved
Number of times the minor batting highlight (default 50 runs) was achieved
Total number of wickets
Number of times the bowling highlight (default 5 wkts) was achieved
Total number of sixes
Total number of catches taken
Total number of wicket keeping catches
Total number of stumpings

Each of these values, except the number of runs scored, is multiplied by a weighting factor 
which may be defined using the User Preferences command.



Sort Mode

The Fantasy Cricket report can be sorted on:

Rating Fantasy Cricket Rating
(weighted batting, bowling and fielding performances)

Name Players' names



Print Button

Click the Print button to print the Fantasy Cricket report.



Preview Button

Click the Preview button to preview the Fantasy Cricket report.



Cancel Button

Click the Cancel button to continue without producing a Fantasy Cricket report.



Fantasy Cricket Preview

The Fantasy Cricket Preview allows you to view the selected Fantasy Cricket report before 
printing:

Print Button
Cancel Button

You can copy the Fantasy Cricket report to the Windows Clipboard, from where it may be 
pasted into other applications, by pressing the <CTRL> and <INSERT> or <CTRL> and 
<C> keys together.



Print Button

Click the Print button to print the Fantasy Cricket report.



Cancel Button

Click the Cancel button to exit from the Fantasy Cricket preview.



Captains' Summary    (Statistics Menu)

The Captains' Summary command allows you to produce a report, for one or more clubs 
over one or more seasons, showing the total number of matches played, won, lost, drawn 
etc. by each captain:

Drive List
Directory List
Database List
Statistics Heading
Database Sort Mode
Day
Team
Type of Match
Sort Mode
Qualification
Print Button
Preview Button
Cancel Button



Sort Mode

The Captains' Summary can be sorted on:

Matches Total number of matches as captain
Won Total number of matches won
Lost Total number of matches lost
Drawn Total number of matches drawn
Tied Total number of matches tied
Abandoned Total number of matches abandoned
Won (%) Percentage of matches won
Lost (%) Percentage    of matches lost
Drawn (%) Percentage    of matches drawn
Tied (%) Percentage    of matches tied
Abandoned (%) Percentage    of matches abandoned
Name Players' names



Qualification

You can choose to split the Captains' Summary into two lists based on:

Matches Total number of matches as captain

The number of Matches necessary to qualify for the main Captains' Summary can be in the 
range 0 - 9999,    players failing to satisfy the qualification will be included in an 'Also 
Captained' list.

Note: If this field is left blank, all players will be included in a single list.



Print Button

Click the Print button to print the Captains' Summary report.



Preview Button

Click the Preview button to preview the Captains' Summary report.



Cancel Button

Click the Cancel button to continue without producing a Captains' Summary report.



Captains' Summary Preview

The Captains' Summary Preview allows you to view the selected Captains' Summary before 
printing:

Print Button
Cancel Button

You can copy the Captains' Summary to the Windows Clipboard, from where it may be 
pasted into other applications, by pressing the <CTRL> and <INSERT> or <CTRL> and 
<C> keys together.



Print Button

Click the Print button to print the Captains' Summary.



Cancel Button

Click the Cancel button to exit from the Captains' Summary preview.



Duck Cup    (Statistics Menu)

The Duck Cup command allows you to produce a report, for one or more clubs over one or 
more seasons, showing the number of ducks 'scored' by each player:

Drive List
Directory List
Database List
Statistics Heading
Database Sort Mode
Day
Team
Type of Match
Sort Mode
Print Button
Preview Button
Cancel Button



Sort Mode

The Duck Cup can be sorted on:

Ducks Total number of ducks 'scored'
Name Players' names



Print Button

Click the Print button to print the Duck Cup report.



Preview Button

Click the Preview button to preview the Duck Cup report.



Cancel Button

Click the Cancel button to continue without producing a Duck Cup report.



Duck Cup Preview

The Duck Cup Preview allows you to view the selected Duck Cup report before printing:

Print Button
Cancel Button

You can copy the Duck Cup to the Windows Clipboard, from where it may be pasted into 
other applications, by pressing the <CTRL> and <INSERT> or <CTRL> and <C> keys 
together.



Print Button

Click the Print button to print the Duck Cup.



Cancel Button

Click the Cancel button to exit from the Duck Cup preview.



Personal Review    (Statistics Menu)

The Personal Review command allows you to produce a review, for one or more clubs 
over one or more seasons, of a particular player's performances in each match:

Drive List
Directory List
Database List
Statistics Heading
Database Sort Mode
Day
Team
Type of Match
Initials
Surname
Print Button
Preview Button
Cancel Button



Initials

The player's Initials can be 1 or 2 characters long and will automatically be converted to 
upper-case.



Valid Characters

The following characters can appear in a player's Initials:

a - z    A - Z



Surname

The player's Surname can be 1 - 12 characters long and will be capitalised.



Valid Characters

The following characters can appear in a player's Surname:

a - z    A - Z    -    '



Capitalised Text

If the following character appears in a player's Surname, the next character will 
automatically be converted to upper-case:

- 

Also, if either of the following appear at the beginning of the surname, the next character 
will automatically be converted to upper-case:

'
Mc



Print Button

Click the Print button to print the Personal Review report.



Preview Button

Click the Preview button to preview the Personal Review report.



Cancel Button

Click the Cancel button to continue without producing a Personal Review report.



Personal Review Preview

The Personal Review Preview allows you to view the selected Personal Review before 
printing:

Previous Year Button
Print Button
Cancel Button
Next Year Button

You can copy the Personal Review to the Windows Clipboard, from where it may be pasted 
into other applications, by pressing the <CTRL> and <INSERT> or <CTRL> and <C> 
keys together.



Previous Year Button

Click the Previous Year button to preview the Personal Review for the previous year.

Note: If the Personal Review was only requested for a single year, the Previous Year 
button will not be shown.    Alternatively, if multiple years were requested and the 
Personal Review currently displayed is for the first of these, the Previous Year button 
will be 'greyed-out'.



Print Button

Click the Print button to print the Personal Review.



Cancel Button

Click the Cancel button to exit from the Personal Review preview.



Next Year Button

Click the Next Year button to preview the Personal Review for the next year.

Note: If the Personal Review was only requested for a single year, the Next Year 
button will not be shown.    Alternatively, if multiple years were requested and the 
Personal Review currently displayed is for the last of these, the Next Year button will 
be 'greyed-out'.



Admin Menu

The Admin Menu contains the following commands:

Player Database
Phone Book
Print Availabilities
Print Rota



Player Database    (Admin Menu)

The Player Database command allows you to search the currently loaded database and 
print a report or mailing labels for those players matching the criteria you define.    The 
search criteria can include the player's name, address, home, work or mobile phone 
numbers and membership details:

Initials
Surname
Address
Home Phone
Work Phone
Mobile Phone
Membership
Subscription
Search Button
Cancel Button



Initials

The player's Initials to be searched for can be 1 or 2 characters long and will automatically
be converted to upper-case.

If you include the * 'wild card' character, for example A*, all players whose initials start 
with A will be found in the search.

If this field is left blank, the initials will not be checked during the search.



Valid Characters

The following characters can appear in the search Initials:

a - z    A - Z    *



Surname

The player's Surname to be searched for can be 1 - 12 characters long and will be 
capitalised.

If you include the * 'wild card' character, for example A*, all players whose surnames start 
with A will be found in the search.

If this field is left blank, the surname will not be checked during the search.



Valid Characters

The following characters can appear in the search Surname:

a - z    A - Z    -    '    *



Capitalised Text

If the following character appears in the search Surname, the next character will 
automatically be converted to upper case:

- 

Also, if either of the following appear at the beginning of surname, the next character will 
automatically be converted to upper-case:

'
Mc



Address

The player's Address to be searched for can contain up to 3 lines, each of which can be up
to 25 characters long.    The first 2 lines of the address will be capitalised and the third line 
will automatically be converted to all upper-case.

If you include the * 'wild card' character in an address line, for example if you set the third 
line to A*, all players whose third address lines start with A will be found in the search.

If an address line is left blank, that address line will not be checked during the search.



Valid Characters

The following characters can appear in the search Address:

a - z    A - Z    0 - 9    ,    .    -    /    '    <space>    *

Note: You cannot enter two consecutive spaces.



Capitalised Text

If any of the following characters appear in the first two lines of the search Address, the 
next character will automatically be converted to upper case:

&    ,    .    -    /    <space>

Also, if either of the following appear at the beginning of a word, the next character will 
automatically be converted to upper-case:

'
Mc



Home Phone

The players' Home Phone number to be searched for can be up to 20 characters long.

If you include the * 'wild card' character, for example 1*, all players whose home phone 
numbers start with 1 will be found in the search.

If this field is left blank, the home phone number will not be checked during the search.



Valid Characters

The following characters can appear in the search Home Phone number:

0 - 9    -    <space>    *

Note: You cannot enter two consecutive spaces.



Work Phone

The players' Work Phone number to be searched for can be up to 20 characters long.

If you include the * 'wild card' character, for example 1*, all players whose work phone 
numbers start with 1 will be found in the search.

If this field is left blank, the work phone number will not be checked during the search.



Valid Characters

The following characters can appear in the search Work Phone number:

0 - 9    -    x    X    <space>    *

Note: You cannot enter two consecutive spaces.



Mobile Phone

The players' Mobile Phone number to be searched for can be up to 20 characters long.

If you include the * 'wild card' character, for example 1*, all players whose mobile phone 
numbers start with 1 will be found in the search.

If this field is left blank, the mobile phone number will not be checked during the search.



Valid Characters

The following characters can appear in the search Mobile Phone number:

a - z    A - Z    0 - 9    -    <space>    *

Note: You cannot enter two consecutive spaces.



Membership

Select the player's Membership type to be searched for from the list of possible 
membership types.

If this field is set to All, the membership will not be checked during the search.

The membership types available may be changed using the User Preferences command.



Subscription

Select the player's Subscription status to be searched for from the following list:

All
Paid
Not Paid

If this field is set to All, the subscription status will not be checked during the search.



Search Button

Click the Search button to start searching the currently loaded database for players who 
match the defined search criteria.



Cancel Button

Click the Cancel button to continue without searching the database.



Player Database Search Preview

The results of the Player Database search are displayed allowing you to preview them 
before printing a report or mailing labels:

Print Report Button
Print Labels Button
Cancel Button

You can copy the Player Database search results to the Windows Clipboard, from where 
they may be pasted into other applications, by pressing the <CTRL> and <INSERT> or 
<CTRL> and <C> keys together.



Print Report Button

Click the Print Report button to print a report containing the results of the Player 
Database search.



Print Labels Button

Click the Print Labels button to print mailing labels for the players identified by the Player 
Database search.



Cancel Button

Click the Cancel button to exit from the Player Database search results preview.



Label Print Options

You can specify the way in which mailing labels are printed:

Number of Copies
Print Order



Number of Copies

The Number of Copies (1 - 9) of the mailing labels to be printed.



Print Order

The order in which the mailing labels should be printed:

Batch
Sequential

Note:  If the Number of Copies has been set to 1, these fields will be 'greyed out'.



Batch

Select Batch if you require the copies of the mailing labels to be printed in batches:

Player 1, Player 2, Player 3, Player 4 ....and so on for all the selected players
then
Player 1, Player 2, Player 3, Player 4 ....and so on for all the selected players
....
....
and so on for all the copies



Sequential

Select Sequential if you require the copies of the mailing labels to be printed in sequence:

Player 1, Player 1, Player 1, Player 1 ....and so on for all the copies
then
Player 2, Player 2, Player 2, Player 2 ....and so on for all the copies
....
....
and so on for all the selected players



OK Button

Click the OK button to print the specified number of mailing labels for the.players identified
by the Player Database search.



Cancel Button

Click the Cancel button to exit without printing the mailing labels.



Phone Book    (Admin Menu)

The Phone Book command allows you to auto-dial players' home, work or mobile phone 
numbers if you have a suitable modem:

Player List
Home Phone Button
Work Phone Button
Mobile Phone Button
Cancel Button

Before you use this facility, you should check that Cricket Averages for Windows is 
correctly configured for your modem.



Player List

The Player List contains the names of all the players in the currently loaded database.    If 
you want to telephone a player at home or work, select the player from the list and click 
the Home Phone button, Work Phone button or Mobile Phone button.



Home Phone Button

Click the Home Phone button to dial a player's home phone number.

Note: If no home phone number has been defined for a particular player, the Home 
Phone Button will be 'greyed-out'.



Work Phone Button

Click the Work Phone button to dial a player's work phone number.

Note: If no work phone number has been defined for a particular player, the Work 
Phone Button will be 'greyed-out'.



Mobile Phone Button

Click the Mobile Phone button to dial a player's mobile phone number.

Note: If no mobile phone number has been defined for a particular player, the 
Mobile Phone Button will be 'greyed-out'.



Cancel Button

Click the Cancel button to continue without auto-dialling players phone numbers.



Print Availabilities    (Admin Menu)

The Print Availabilities command prints a list, with the dates of the matches along the 
top and the players down the side, which you can then pin up on your notice board for your
members to indicate when they are available to play.

Month
OK Button
Cancel Button



Month

Select the Month for the availabilites from the following list:

All
January
February
March
April
May
June
July
August
September
October
November
December

Note: You can select multiple months (eg. April, May and June) by selecting the first 
month and then holding down the <CTRL> key as you select the subsequent months
or you can select a range of months (eg. April - August) by selecting the first month 
and then holding down the <SHIFT> key as you select the last month.



OK Button

Click the OK button to print the specified availability list.



Cancel Button

Click the Cancel button to continue without producing an availability list.



Print Rota    (Admin Menu)

The Print Rota command allows you to print rotas (eg. for teas, bar duty, working parties 
etc.) for various days, teams, types of match and venues for the currently loaded database.
You can then pin up these rotas up on your notice board for your members to indicate when
they can perform their duties (or, more likely, for you to allocate them duties!).

Rota Heading
Day
Team
Type of Match
Venue
OK Button
Cancel Button



Rota Heading

The Rota Heading can be 1 - 30 characters long and will be capitalised.



Valid Characters

The following characters can appear in the Rota Heading:

a - z    A - Z    0 - 9    &    ,    .    -    /    '    <space>

Note: You cannot enter two consecutive spaces.



Capitalised Text

If any of the following characters appear in the Rota Heading, the next character will 
automatically be converted to upper-case:

-    /    <space>



Day

Select the Day for the rota from the following list:

All
Saturday
Sunday
Monday
Tuesday
Wednesday
Thursday
Friday

Note: You can select multiple days (eg. Saturday, Monday and Wednesday) by 
selecting the first day and then holding down the <CTRL> key as you select the 
subsequent days or you can select a range of days (eg. Saturday - Wednesday) by 
selecting the first day and then holding down the <SHIFT> key as you select the last
day.



Team

Select the Team for the rota from the following list:

All
1
2
3
4
5
6
7
8
9

Note: You can select multiple teams (eg. 1, 3 and 5) by selecting the first team and 
then holding down the <CTRL> key as you select the subsequent teams or you can 
select a range of teams (eg. 1 - 5) by selecting the first team and then holding down 
the <SHIFT> key as you select the last team.



Type of Match

Select the Type of Match for the rota from the list of possible membership types.

The match types available may be changed using the User Preferences command.

Note: You can select multiple match types (eg. Friendly, League and Tour) by 
selecting the first type and then holding down the <CTRL> key as you select the 
subsequent types or you can select a range of match types (eg. Friendly, League, 
Cup, Tour) by selecting the first type and then holding down the <SHIFT> key as you
select the last type.



Venue

The rota can be produced which contains all the matches, only the home matches or only 
the away matches.



All Matches

Select All Matches if you want to produce a rota containing all the matches.



Home Matches

Select Home Matches if you want to produce a rota containing only the home matches.



Away Matches

Select Away Matches if you want to produce a rota containing only the away matches.



OK Button

Click the OK button to print the specified rota.



Cancel Button

Click the Cancel button to continue without producing a rota.



Options Menu

The Options Menu contains the following commands:

Auto Save
Sound
Tool Tips
User Preferences
Printer Fonts
Label Format
Dialler Setup



Auto Save    (Options Menu)

The Auto Save command controls a safety feature which, if enabled, will periodically save 
the currently loaded database.    The Auto Save menu option is shown checked when the 
Auto Save feature is enabled.

Auto Save
Auto Save Period
OK Button
Cancel Button



Auto Save

Check the Auto Save Enable box if you require the currently loaded database to be 
periodically saved.    The time period between saves is defined by the Auto Save Period.



Auto Save Period

The Auto Save Period defines the time (1 - 60 minutes) between automatic saves of the 
currently loaded database.



OK Button

Click the OK button to accept the changes to the Auto Save settings.



Cancel Button

Click the Cancel button to retain the original Auto Save settings.



Sound    (Options Menu)

The Sound command toggles the sound, which is used to indicate important events or 
errors, on and off.    The Sound menu option is shown checked when the sound is turned on.



Tool Tips    (Options Menu)

The Tool Tips command toggles the display of short prompts, which indicate the function 
of the tool bar buttons, on and off.    The Tool Tips menu option is shown checked when the 
tool tips are turned on.



User Preferences    (Options Menu)

The User Preferences command allows you to define the match types, memebership 
types, statistics highlights and Fantasy Cricket weightings:

Match Types
Statistics Highlights
Fantasy Cricket Weightings
Membership Types
OK Button
Cancel Button



Match Types

You can define the 8 Match Types to be used by Cricket Statistics for Windows.    Each 
match type can be 1 - 16 characters long and will be capitalised.

Note: The match types are not linked to any particular database but are global.    
Therefore, if you change the first match type from Friendly (the default) to League 
& Cup, matches which had previously been defined as Friendly in any database will 
become League & Cup.



Valid Characters

The following characters can appear in the Match Types:

a - z    A - Z    0 - 9    &    ,    .    -    /    '    <space>

Note: You cannot enter two consecutive spaces.



Capitalised Text

If any of the following characters appear in the Match Types, the next character will 
automatically be converted to upper-case:

&    ,    .    -    /    '    <space>



Statistics Highlights

You can define the individual performances which will be highlighted in the Batting and 
Bowling Averages:

Major Batting Highlight
Minor Batting Highlight
Bowling Highlight



Major Batting Highlight

You can define the Major Batting Highlight, which can be in the range (minor batting 
highlight + 1) - 999.    The number of times players score at least the Major Batting 
Highlight in a game will be reported in the Batting Averages.



Minor Batting Highlight

You can define the Minor Batting Highlight, which can be in the range 0 - (major batting 
highlight - 1).    The number of times players score at least the Minor Batting Highlight 
(but less than the Major Batting Highlight) in a game will be reported in the Batting 
Averages.



Bowling Highlight

You can define the Bowling Highlight, which can be in the range 0 - 10, for the Bowling 
Averages.    The number of times players take at least the number of wickets in a game 
specified in the Bowling Highlight will be reported in the Bowling Averages.



Fantasy Cricket Weightings

You can define the following weighting factors for use in calculating a player's Fantasy 
Cricket Rating:

Major Batting Highlight
Minor Batting Highlight
Wickets
Bowling Highlight
Sixes
Catches
Wicket Keeping Catches
Stumpings



Fantasy Cricket Major Batting Highlight

You can define a weighting factor for the Major Batting Highlight, for use in calculating a
player's Fantasy Cricket Rating, which can be in the range 0 - 999.



Fantasy Cricket Minor Batting Highlight

You can define a weighting factor for the Minor Batting Highlight, for use in calculating a
player's Fantasy Cricket Rating, which can be in the range 0 - 999.



Fantasy Cricket Wickets

You can define a weighting factor for Wickets taken, for use in calculating a player's 
Fantasy Cricket Rating, which can be in the range 0 - 999.



Fantasy Cricket Bowling Highlight

You can define a weighting factor for the Bowling Highlight, for use in calculating a 
player's Fantasy Cricket Rating, which can be in the range 0 - 999.



Fantasy Cricket Sixes

You can define a weighting factor for Sixes, for use in calculating a player's Fantasy Cricket
Rating, which can be in the range 0 - 999.



Fantasy Cricket Catches

You can define a weighting factor for Catches, for use in calculating a player's Fantasy 
Cricket Rating, which can be in the range 0 - 999.



Fantasy Cricket Wicket Keeping Catches

You can define a weighting factor for Wicket Keeping Catches, for use in calculating a 
player's Fantasy Cricket Rating, which can be in the range 0 - 999.



Fantasy Cricket Stumpings

You can define a weighting factor for Stumpings, for use in calculating a player's Fantasy 
Cricket Rating, which can be in the range 0 - 999.



Membership Types

You can define the 8 Membership Types to be used by Cricket Statistics for Windows. 
Each membership type can be 1 - 16 characters long and will be capitalised.

Note: The membership types are not linked to any particular database but are 
global.    Therefore, if you change the first membership type from Full (the default) to 
Country, players who had previously been defined as a Full members in any 
database will become Country members.



Valid Characters

The following characters can appear in the Membership Types:

a - z    A - Z    0 - 9    &    ,    .    -    /    '    <space>

Note: You cannot enter two consecutive spaces.



Capitalised Text

If any of the following characters appear in the Match Types, the next character will 
automatically be converted to upper-case:

&    ,    .    -    /    '    <space>



OK Button

Click the OK button to accept the changes to the User Preferences.



Cancel Button

Click the Cancel button to retain the original User Preferences.



Printer Fonts    (Options Menu)

The Printer Fonts command allows you to select the fonts to be used in printed reports:

Font Names
Font Sizes
Landscape Enable
OK Button
Cancel Button

If the default Windows printer has changed, the fonts available on the new printer will be 
checked for their suitability before the Printer Fonts window is displayed.



Font Names

Select each of the required Font Names from the lists of available fonts:

Portrait

Large Font Used for headings
Normal Font Used for the body of text in most reports, labels etc.
Small Font Used for the body of text in the Match Review (if landscape printing is not 

enabled) and Print Availabilities

Landscape (only displayed if your printer supports landscape printing)

Large Font Used for the heading for the Match Review (if landscape printing is enabled)
Normal Font Not currently used
Small Font Used for the body of text in the Match Review (if landscape printing is enabled)



Font Sizes

Select each of the required Font Sizes from the lists of available sizes:

Portrait

Large Font Used for headings
Normal Font Used for the body of text in most reports, labels etc.
Small Font Used for the body of text in the Match Review (if landscape printing is not 

enabled) and Print Availabilities

Landscape (only displayed if your printer supports landscape printing)

Large Font Used for the heading for the Match Review (if landscape printing is enabled)
Normal Font Not currently used
Small Font Used for the body of text in the Match Review (if landscape printing is enabled)



Landscape Enabled

Check the Landscape Enabled box if you want to print the Match Review in landscape 
mode.

Note: The Landscape Enabled box is only displayed if your printer supports 
landscape printing.



OK Button

Click the OK button to accept the changes to the Printer Font settings.



Cancel Button

Click the Cancel button to retain the original Printer Font settings.



Label Format    (Options Menu)

The Label Format command allows you to define the format of the label stationery to be 
used when printing mailing labels from the Player Database:

Stationery Type
Units
Labels Across
Label Width
Left Margin
Horizontal Gap
Labels Down
Label Height
Top Margin
Vertical Gap
OK Button
Test Button
Cancel Button



Stationery Type

You can specify whether the labels you are using are on Single Sheet or Continuous 
stationery.



Single Sheet Stationery

Select Single Sheet if you are using labels which are on single sheet stationery.

Note: Selecting Single Sheet will reset the number of labels down to 1 and clear the 
Label Height, Top Margin and Vertical Gap.



Continuous Stationery

Select Continuous if you are using labels which are on continuous stationery.

Note: Selecting Continuous will clear the Label Height and Vertical Gap.



Units of Measurement

You can choose whether you want to specify the dimensions of the labels in Inches or 
Millimetres.



Inches

Select Inches if you want to specify the dimensions of the labels in inches.

Note: Selecting Inches will convert the existing label dimensions to inches.



Millimetres

Select Millimetres if you want to specify the dimensions of the labels in millimetres.

Note: Selecting Millimetres will convert the existing label dimensions to millimetres.



Labels Across

Select the number of Labels Across the page from the following list:

1
2
3

Note: Changing the number of Labels Across will clear the Label Width, Left Margin 
and Horizontal Gap.



Label Width

The Width of the labels.    The value entered will be checked to ensure that the required 
number of labels, with the specified width, margin and gap, can fit across the page.



Left Margin

The Left Margin is the gap between the left hand edge of the stationery and the first 
label.    The value entered will be checked to ensure that the required number of labels, with
the specified width, margin and gap, can fit across the page.



Horizontal Gap

The Horizontal Gap is the gap between the right hand edge of one label and the left hand 
edge of the next label.    The value entered will be checked to ensure that the required 
number of labels, with the specified width, margin and gap, can fit across the page.

Note: If the number of Labels Across has been set to 1, the Horizontal Gap will be 
'greyed out'.



Labels Down

Select the number of Labels Down the page from the following list:

1
2
3
4
5
6
7
8

Note: If the Stationery Type has been set to Continuous Stationery, the Labels Down 
will be 'greyed out'.

Changing the number of Labels Down will clear the Label Height, Top Margin and 
Vertical Gap.



Label Height

The Height of the labels.    The value entered will be checked to ensure that the required 
number of labels, with the specified height, margin and gap, can fit down the page.



Top Margin

The Top Margin is the gap between the top edge of the stationery and the first label.    The
value entered will be checked to ensure that the required number of labels, with the 
specified height, margin and gap, can fit down the page.

Note: If the Stationery Type has been set to Continuous Stationery, the Top Margin 
will be 'greyed out'.



Vertical Gap

The Vertical Gap is the gap between the bottom edge of one label and the top edge of the
next label.    The value entered will be checked to ensure that the required number of 
labels, with the specified height, margin and gap, can fit down the page.

Note: If the number of Labels Down has been set to 1, the Vertical Gap will be 
'greyed out'.



OK Button

Click the OK button to accept the changes to the Label Format settings.



Test Button

Click the Test button to print a series of labels using the settings you have defined.



Cancel Button

Click the Cancel button to retain the original Label Format settings.



Dialler Setup    (Options Menu)

The Dialler Setup command allows you to define the COM port, speed, data format, flow 
control method, initialisation / dial / hang up commands and status messages for the 
modem you will be using to auto-dial players' from the Phone Book.

COM Port
Speed
Flow Control
Data Bits
Stop Bits
Parity
Modem Init String
Dial Prefix String
Dial Suffix String
Hang Up Command
OK Result Code
No Dial Tone Result Code
Busy Result Code
Auto Redial
Redial Period
OK Button
Cancel Button



COM Port

Select the COM Port to which your modem is connected from the following list:

COM1
COM2
COM3
COM4



Speed

Select the Speed (Data Rate) at which your modem operates from the following list:

110
300
600
1200
2400
4800
9600
19200



Flow Control

Select the Flow Control method your modem uses from the following list:

None
Xon/Xoff
RTS/CTS



Data Bits

Select the number of Data Bits your modem requires in each character from the following 
list:

4
5
6
7
8



Stop Bits

Select the number of Stop Bits your modem requires in each character from the following 
list:

1
1.5
2



Parity

Select the Parity your modem requires from the following list:

None
Odd
Even
Mark
Space



Modem Init String

The Modem Init String to be sent to initialise your modem can be up to 25 characters 
long.



Valid Characters

The following characters can appear in the Modem Init String:

a - z    A - Z    0 - 9    &    ,    ;    =    \    ?    <space>



Dial Prefix String

The Dial Prefix String to be sent to your modem before any phone number can be up to 
25 characters long.



Valid Characters

The following characters can appear in the Dial Prefix String:

a - z    A - Z    0 - 9    &    ,    ;    =    \    ?    <space>



Dial Suffix String

The Dial Suffix String to be sent to your modem after any phone number can be up to 25 
characters long.



Valid Characters

The following characters can appear in the Dial Suffix String:

a - z    A - Z    0 - 9    &    ,    ;    =    \    ?    <space>



Hang Up Command

The Hang Up Command to be sent to your modem to hang up the line can be up to 25 
characters long.



Valid Characters

The following characters can appear in the Hang Up Command:

a - z    A - Z    0 - 9    +    &    ,    ;    =    \    ?    <space>



OK Result Code

The OK Result Code your modem responds with to indicate a command has been 
accepted can be up to 25 characters long.



Valid Characters

The following characters can appear in the OK Result Code:

a - z    A - Z    0 - 9    <space>



No Dial Tone Result Code

The No Dial Tone Result Code your modem responds with to indicate it has not detected 
a dial tone can be up to 25 characters long.



Valid Characters

The following characters can appear in the No Dial Tone Result Code:

a - z    A - Z    0 - 9    <space>



Busy Result Code

The Busy Result Code your modem responds with to indicate the dialled number is busy 
can be up to 25 characters long.



Valid Characters

The following characters can appear in the Busy Result Code:

a - z    A - Z    0 - 9    <space>



Auto Redial

Check the Auto Redial box if you want to automatically redial a number if it is busy.    The 
delay between attempts is defined by the Redial Period.



Redial Period

The Redial Period defines the time delay (10 - 60 seconds) before automatically redialling
a busy number.



OK Button

Click the OK button to accept the changes to the Dialler settings.



Cancel Button

Click the Cancel button to retain the original Dialler settings.



Help Menu

The Help Menu contains the following commands:

Contents
Search for Help on
How to Use Help
About Cricket Statistics for Windows

And, if the program has not been registered, the following additional commands:

How to Register
Enter Registration Details
Print Order Form



Contents    (Help Menu)

The Contents command displays the help contents for Cricket Statistics for Windows.   
From this opening screen, you can jump to detailed help on individual commands and 
techniques.

Once you are in the Help system, you can click the Index (Windows 3.0) or Contents 
(Windows 3.1) button whenever you want to return to the opening screen.



Search for Help on    (Help Menu)

The Search for Help on command displays a dialogue from which you can search for help 
on a particular topic.



How to Use Help    (Help Menu)

The How to Use Help command displays information on using the Help system.



How to Register (Help Menu)

The How to Register command displays information on registering Cricket Statistics for
Windows.



Enter Registration Details (Help Menu)

The Enter Registration Details command allows you to enter your registration number, 
which will be sent to you when you register your copy of Cricket Statistics for Windows. 
Registration will enable you to work with    multiple databases and will stop the annoying 
registration reminder dialogue being displayed.

Name
Registration Number
OK Button
Cancel Button



Name

Your Name can be 1 - 32 characters long and will be capitalised.

Please enter your Name EXACTLY as supplied on your registration document.



Valid Characters

The following characters can appear in your Name:

a - z    A - Z    -    ' <space>

Note: You cannot enter two consecutive spaces.



Capitalised Text

The first character of your forename(s) and surname will be converted to upper case and all
other characters will be converted to lower case.

If the following character appears in your surname, the next character will automatically be
converted to upper case:

- 

Also, if either of the following appear at the beginning of your surname, the next character 
will automatically be converted to upper-case:

'
Mc



Registration Number

Your Registration Number can be 1 - 32 characters long.

Please enter your Registration Number EXACTLY as supplied on your registration 
document.



Valid Characters

The following characters can appear in your Registration Number:

0 - 9    -



OK Button

Click the OK button when you have finished entering your registration details.



Cancel Button

Click the Cancel button to continue without entering your registration details.



Print Order Form (Help Menu)

The Print Order Form command prints a form, which you should complete and mail to 
me, together with your cheque/postal order for £20.00, to register your copy of Cricket 
Statistics for Windows.



About Cricket Statistics for Windows    (Help Menu)

The About Cricket Statistics for Windows command displays a dialogue showing a 
copyright notice,    the program version number and a list of acknowledgements.

Until you register your copy of Cricket Statistics for Windows, a second dialogue 
containing a reminder (commonly known as a 'Nag Screen') will be displayed when you 
click the OK button.

OK Button



OK Button

Click the OK button when you have finished reading the copyright notice/registration 
reminder.






